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Learning Lab: Interoperability with GNSS, Google and AGOL  

 

The learning problem 
In the GEO arena, we often need to share data among organizations that use different GIS applications 
(ArcGIS vs. QGIS vs. MapInfo) or, for example, that use a GIS application made by one company, a GPS 
application made by another company, and a geoprocessing model that was developed in-house. To 
share data across these different platforms, we rely on a philosophy called interoperability. 

Interoperability is a mindset that seeks to allow different information technologies and 
software applications to exchange data easily; to prevent the loss or corruption of data during 
exchange; and to minimize the cost (e.g., time, labor) to handle the exchange.  Technically speaking, 
interoperability is made possible by adopting standards (e.g. file standards include: CSV, JSON, 
shapefile, TIFF, and JPG; metadata standards include ISO and FGDC).  Culturally speaking, 
interoperability is made possible by understanding our partners’/clients’/customers’ needs and 
catering to them.   
 
The practical vehicle for learning 
The Harrisburg Mural Festival (HMF) is a city beautification project.  It started during the first two 
weeks of September 2017 and involved the painting of large murals in Harrisburg’s Downtown and 
Midtown neighborhoods. 
 HMF organizers published two maps before the event. One map (printed hardcopy) showed 
the locations of 11 planned mural-painting sites as well as the locations of 8 extant murals that were 
painted before the festival. The second map (posted online) shows 14 planned sites but none of the 
murals that existed prior.  Not only do the two maps differ in number and content, but not all the 
plotted locations agree.  So, there seems to be some uncertainty and a need for a third and definitive 
map that correctly marks all the locations of all of the murals in Harrisburg.  Our purpose is, therefore, 
to answer the question: Where are all the murals located in Harrisburg and what are their attributes?  
 
Our information technologies 
We’re going to use three different information technologies en route to answering our question, and 
we need these technologies to interoperate effectively. 
 
1. Esri Story Maps 
ArcGIS Online is a cloud-based tool.  It allows people and organizations to share geographic 
information, geoprocessing services, and media within the familiar browser environment.  Specifically, 
you can use ArcGIS Online to build maps and interactive map applications.  A “Map Tour” is a type of 
map application that’s used for presenting geographic information with compelling photographic or 
media elements. In this lab, we’re going to use Esri’s “Map Tour” template to help us present a map 
and a compelling set of mural photographs.   
  
2. Google Sheets 
Google Sheets is a spreadsheet tool that looks and functions much like any other spreadsheet tool, 
but - because it is a cloud-based app - it offers you some powerful sharing and interoperability options.  
If you know how to use Microsoft Excel ®, then you’ll feel comfortable using Google Sheets.  In this lab, 
we’re going to use Google Sheets to build a spreadsheet of point locations and their attributes because 
it is easy to use and it has some pretty cool data sharing features.   
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3. Trimble Global Navigation Satellite Systems 
In this lab, you are going to learn how to conduct a coordinate and attribute survey of Harrisburg 
murals using a differential grade Trimble device and GPS Pathfinder Office software. 

A Global Navigation Satellite System (GNSS) is a class of geotechnology that is useful for 
measuring location, elevation and time; recording attributes; and assisting navigation and tracking. 
Many environmental projects involve both fieldwork with GNSS and office work with GIS, so it is useful 
to learn how to leverage both technologies.  

Geospatial data are exchangeable between Trimble and Esri software because both 
technologies recognize the WGS84 geographic coordinate system as a standard way to spatially 
reference locations and both adopted the same data exchange formats (i.e., their proprietary files can 
be exported to ASCII text files, shapefiles, etc.).  In other words, we can achieve interoperability with 
ArcGIS and Trimble because both systems use the same standards. 

Most GNSS devices, including Trimble devices, come in one of three grades: recreational, 
differential, and survey: 

1. Recreational devices (e.g., mobile phones and pocket receivers) are typically small hand-held 
computers that can be used for place finding, waypoint marking, and geotagging media; under 
only the very best conditions, they can make repeated horizontal coordinate measures with ±3 
meters of precision.   

2. Differential grade devices have larger antennas, better hardware, and better software than 
recreational devices. When coupled with post-processing techniques, differential grade 
devices can make repeated horizontal coordinate measures with sub-meter precision.   

3. Survey grade devices are the state-of-the-art and expensive.  They can make repeated 
horizontal coordinate measures with ±1 centimeter of precision in real time.  

 
 
Objectives 
In this lab, we are going to: 

1. use GNSS technology to measure mural locations and record mural attributes; 

2. build and share a cloud-based spreadsheet of mural locations and their attributes; 

3. build a web map application that operates within a browser;  

and 

4. use some very specialized GIS knowledge and training to develop these materials so that 
people without GIS skills can access and interact with the data you collected.   

To accomplish our objectives, we need to develop a workflow that assures the data we collect and 
share are accurate, consistent, and complete. Bolstad (2016: p617-624) 
 
 
Before collecting any data, we need to plan: 

1. Perform GNSS mission planning to identify the blocks of time when GNSS satellite-receiver 
geometries are optimal. 

2. Set-up our digital cameras to capture images with a 4:3 aspect ratio (4 pixels wide for every 3 
pixels high). 

3. Identify the vector feature class (point, line, or polygon) that is most appropriate for 
representing “a mural”.  In this case, we’re going to use points. 
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4. Identify the necessary attributes for every mural.  In this case, we’re going to record: 
a. Mural title 
b. Mural description 
c. Artist’s name 
d. Artist’s Instagram handle 
e. Artist’s website URL 
f. Artist description 

 
While in the field: 

5. Conduct coordinate and attribute surveys with good equipment and during the good blocks of 
time (see mission planning). 

 
Back in the lab: 

6. Post-process the GPS data to differentially correct the raw positions that support each feature; 
7. Export the corrected mural features to a file in CSV format; 
8. Prepare and upload the CSV file to Google Drive; 
9. Convert the CSV file to a Google Sheet; 
10. Publish the Google Sheet as a CSV file (wait, what huh?????) 
11. Use ArcGIS Online to build a web map using the published CSV file 
12. Use ArcGIS Online to develop a web map app of Harrisburg Murals 

Methods for using Trimble GPS devices – Part 1: Mission planning & preparation 
Step 1. Perform GNSS mission planning.  Bolstad (2016: p203-213) 
Anyone who has used a car navigation system or a mobile device knows that your ‘blue dot’ can be 
plotted incorrectly.  Usually, that’s because the device was set to measure positions quickly under any 
satellite constellation rather to wait until a suitable constellation is available for measuring positions 
reliably.  GNSS mission planning is the process of predicting when the satellite constellation above 
your work site will be suitable for collecting reliable GNSS data.   

Use John Deere’s NAVCON’s Satellite Predictor application (link below) to plan your mission and 
to identify blocks of time when GPS satellites-receiver geometries will be optimal.   
 

http://satpredictor2.deere.com/lookup 
 

1. Page 1 
a. Choose Your location: Either type in “Harrisburg, PA” or use the map to choose a 

spot in Harrisburg, PA.  [Continue] 
2. Page 2 

a. Choose the right Time Zone. If you’re planning field work in Pennsylvania between 
March and November, then you want Eastern Daylight Saving Time (EDT).  If you’re 
planning fieldwork in Pennsylvania between November and March, then you want 
Eastern Standard Time (EST). 

b. Our Trimble devices communicate with the US fleet of [X] GPS satellites only; they do 
not communicate with the Russian fleet of [ ] GLONASS satellites. 

c. Because we’ll be working among tall buildings, we cannot assume we’ll have an un-
obstructed view of the sky along our entire horizon.  Specify a 15˚ Elevation Mask 
above our work site horizon.  [Continue] 

3. Page 3 
a. Choose the Date we will be in the field. 

http://satpredictor2.deere.com/lookup


Read everything before doing anything!   Visualize your final product.                                                                                                                                                                                       4 

b. Review the expected satellite Visibility at our designated place and time.  Take notes 
about when 6 or fewer satellites are expected to be visible, for using GPS during those 
blocks of time could yield less-than optimal data.  [Print report] 

c. Review the expected DOPs.  A DOP value works like a golf score – lower numbers are 
better (see Figure 5-12 in Bolstad ,2016: p213).  Values equal to or less than 3 are 
considered good; between 3 and 6, moderate; and greater than 6, poor.   
H = Horizontal measures (long,lat).  V = Vertical measures (elevation).  P = Position 
(horizontal and vertical combined).  [Print report] 
 

Question 1:  Report each ‘bad’ block of time (from start time to end time) when the HDOPs are 
expected to be equal to 3.0 or greater. This is important because we want to avoid 
doing any GPS work during those bad blocks of time.  Attach copies of your NAVCON 
reports to your lab report. 

 
Steps 2 and 3. Thinking about what needs to be mapped and what needs to be observed. 
Begin a session of GPS Pathfinder Office and setup a New… project named Harrisburg in your GIS3 
folder.1  Direct the Project Folder: to either your T: drive; the C:\Geotemp folder; or a workspace 
on your external memory device.   
 
Next, use Trimble’s Utility > Data Dictionary Editor tool to help you prepare mural attribute 
collection.  When the tool opens, create a data dictionary called HBGMF-<your initials>.ddf 
and save it in your folder.  Set up your data dictionary as follows: 
 

1. Name:  HBGMuralFest-<your initials> 
2. Comment: Fall 2017 
3. Version: TerraSync v5.00 and later 

 
4. Create a New point Feature… called Mural with the following settings and symbol: 

a. Default setting 
i. Select a 1-second position logging interval; 

ii. Use a minimum of 120 raw positions to support each mural; 
b. Symbol 

i. Choose 20-pt and artsy-looking symbol of any color. 
ii. [ OK ] 

c. Next, create New Attributes… 
i. Text attribute 

1. Name: Mtitle 
2. Comment/Alias: Mural title? 
3. Length: 64 
4. On Creation: Required 
5. On Update: Normal 

ii. Text attribute 
1. Name: Mdescr 
2. Comment/Alias: Describe the mural. 

                                                             
1 You will need to change the project path because you do not have write permissions to the IT Administrator 
account that installed the software. 
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3. Length: 64 
4. On Creation: Required 
5. On Update: Normal 

iii. Numeric attribute 
1. Name: MYear 
2. Comment/Alias: In which year was it painted? 
3. Decimal places: 0 
4. Minimum: 1990 
5. Maximum: 2020 
6. Default: 2017 
7. On Creation: Normal 
8. On Update: Normal 

iv. Text attribute 
1. Name: Aname 
2. Comment/Alias: Artist’s name? 
3. Length: 64 
4. On Creation: Required 
5. On Update: Normal 

v. Menu attribute 
1. Name: Photo 
2. Alias: Did you take a picture? 
3. Menu Attribute Values: 

a. [New…] 
i. Attribute value: Yes 

ii. Default: checked 
iii. Code Value 1: 1 
iv. [Add] 
v. Attribute value: No 

vi. Default: unchecked 
vii. Code Value 1: 0 

viii. [Add] 
4. Display in Field As: Radio Buttons  
5. On creation: Required 
6. On update: Normal 

vi. Numeric attribute 
1. Name: Photos 
2. Comment/Alias: How many? 
3. Decimal places: 0 
4. Minimum: 1 
5. Maximum: 20 
6. Default: 1 
7. On Creation: Normal 
8. On Update: Normal 
9. Condition: [Change] 

a. Enable condition: checked 
b. If this condition is true, “Photo is No”, then: 

i. On creation: Not Visible 
ii. On Update: Not Visible 
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vii. Text field 
1. Name: Comments 
2. Comment/Alias: Open ended comment. 
3. Length: 48 
4. On Creation: Normal 

 
Save your data dictionary file and compare your setup against Figure 1.  If everything looks good, then 
close the editor. 
 

 
 Figure 1. Snapshot of a complete data dictionary. 
 
 
Next, obtain a Trimble device and insert it into the grey cradle (GeoExplorer 3000 series) or connect it 
via USB (Juno series).  Turn on the device (green button).   On your workstation, Microsoft’s Mobile 
Device software should recognize the newly-connected Trimble device and open a port for 
communication.  When prompted, choose “Connect without setting up your device” (we’re not trying 
to sync music libraries or anything like that, just connect).   
 
Next, open Trimble GPS Pathfinder Office’s Data Transfer utility and connect with the GIS Datalogger 
on Windows Mobile device (if it hasn’t already done so).   
 
Next, add your data dictionary file to your send list, then transfer everything on the send list to the 
Trimble device.  Close and Exit the utility. 
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Methods for using Trimble GPS devices – Part 2: Collecting data 
Before beginning any fieldwork, make sure you are prepared with suitable clothing, water, and sun 
protection (e.g., a hat, sunscreen).  Expect to be outside for a few hours, so plan accordingly. 
 
Go to Harrisburg, collect mural data, and take pictures.  Bolstad (2016: 227-239; p96-97) 
 
When you are in the field and ready to start your survey, start GPS / TerraSync (Professional).   
TerraSync is data collection software that works with a GPS receiver, reads satellite signals, and 
calculates positions.  It can take several minutes to ‘lock’ onto all the GPS signals that are above your 
local horizon, so be patient. 
 
On start, TerraSync will display its Status window.  Think of yourself as standing at the center and the 

circle.  The circumference of the circle represents the 360° local horizon around you.  The box symbols 
represent the GPS satellites that are in the volume of space above your horizontal. 
 
Next, choose the Data option from the pull-down menu, which will let you select and use your data 
dictionary: HBGMuralFest-XYZ as a template.  
 
Data file names are auto-generated: the prefix is usually the letter “R” (R for rover); the next two 
characters indicate the month (“09” for September); the next two indicate the day of the month; the 
next two indicate the hour of the day (on a 24-hour clock); and the suffix is usually a letter that auto-
increments (from A to Z) during the hour. Be sure to choose your data dictionary before you Create 
your data file. 
 
Next, enter the height of the GPS antenna above ground (1.5 m is about right for the average person).   
 
Next, if you followed all the directions above, then you should now see 4 buttons: [Mural] and the 
three default feature classes: [Point_generic], [Line_Generic], and [Area_generic]. 
 
When you’re finished with all your field work, then Close the data file, Exit TerraSync, and power 
down the device by holding the green power button.  
 
If the TerraSync software on your Trimble device is still open, then Menu > Exit before inserting it 
back into its cradle.   
 
Insert the device into its cradle or attach it via USB cable.  Microsoft’s Mobile Device software should 
re-open a port for communication.  When prompted, “Connect without setting up your device.”   
 
Start a new session of GPS Pathfinder Office.  Re-open your Harrisburg project. 
 
Next, open the Data Transfer Utility.  Add your data file to your receive list, then transfer all the items 
on the receive list to your Harrisburg folder.  Close Data Transfer.   
 
Question 2:  How did Mission Planning and building a data dictionary change the typical way you do 

fieldwork?   
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Methods for using Trimble GPS devices – Part 3: Post-processing and export 
All that mission planning you did was to ensure that you collected data when optimal conditions were 
predicted.  Working according to plan does not guarantee, however, that field conditions were 
actually optimal, that you collected good data, or that you collected all the data you needed.  

Your raw position data are likely infected with some errors, which means your average feature 
locations can be off from true. For example, tall nearby buildings or trees can interfere with incoming 
satellite signals or, worse, cause them to bounce around before arriving at your device. See Figure 5-
31 in Bolstad (2016, p231). Or, you might have committed some mistakes while learning how to 
use the Trimble device.  Or, you might have started taking short cuts and making blunders the longer 
you worked.  These are just some of the reasons why you never want to give raw data to a client.   
 
Before post-processing, make a copy of your data file (e.g., copyR0*.ssf).  Working with a copy of 
your data will let you practice and play without fear of losing your data.  You’ll always have the original 
*.SSF file as a back-up. 

 
Start a session of GPS Pathfinder Office and re-open your Harrisburg project. Make sure you can see 
the Map, Time Line, Feature Properties, and Position Properties windows. 

 
Next, set the Options > Coordinate System… to US State Plane 1983, Pennsylvania South 3702 
(NAD83).  Set your vertical datum to be Mean Sea Level (via the latest GEOIDxx model).  All coordinate 
values should be displayed in meters. 2     
 
Next, File > Open… your data file (copyR0*.ssf).  If you setup your data dictionary correctly, then 

you should see where your features were measured (Map window) and when they were measured 
(Time Line window).   You can use your cursor to select a feature in either window and the 
corresponding symbol will become selected in the other window.  Notice how the Feature and Position 
attributes change with your selection. 
 
Question 3:  How many mural features are in your mural feature class?   
 
Exploring your raw data 
Use your cursor to select a mural.  The Feature Properties window lets you review the attribute data 
for the mural.  Meanwhile, the Position Properties window reports the average but uncorrected 
Easting, Northing, and Altitude values derived from your sample of 120 positions. 
 
Change the View > Layers > Features… > Not in Feature > Symbol… properties so they have a 
dark color and a thick width.   
 
Next, use the Feature Properties window to Delete your selected feature.  Relax, deleting a feature 
doesn’t actually delete a feature (unless you hit “save”).  Deleting a feature allows you to see the 
sample of raw single-fix position coordinates that support your average feature coordinates.  Change 
map scale and pan to focus on your supporting sample.   
 
Question 4:  How many raw single-fix positions (repeated measures) were used to support the 

average coordinates for your feature? 

                                                             
2  Remember, all GNSS receivers spatially reference positions to the WGS84 ellipsoid model only.  These settings do not 
change the actual geographic coordinates { λ, Φ, h } that you measured; rather, they simply tell the software which spatial 
reference system/projection method you want to use on-screen for display purposes only.     
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Next, use your cursor to select raw positions, one-by-one, and examine their coordinates and DOP 
values.  Use the Position Properties window to see how your measuring method changed over time as 
GPS satellites entered or left the constellation above your local horizon.   
 
Question 5:  Describe any changes that occurred to your satellites-receiver geometry as you 

collected these raw data.   
 
Question 6:  Do you notice any sequence of raw single-fix positions that seems to fall along an 

apparent straight line?  If so, do the elevations or coordinates drift as you poke along 
the line? 

 
Question 7:  Change map scale and look at the entire pool of supporting positions.   
 

a) Does your pool of supporting positions have a central cluster?  If so, how wide is it?  (Use 
the Measure tool.  You might have to change your display units to show meters; not 
kilometers.)   
 

b) How far apart are the most distant pair of raw positions?  
 
c) Interpret your answers above to characterize how consistently your measuring 

equipment/method produced the same result during repeated measures?  In other words, 
use the two distances you just measured to describe the precision of your 
equipment/method. 

 
Return to your Feature Properties window and [Un-delete] your selected feature.   
 
 
Applying differential corrections to your raw data.  Bolstad (2016: p215-221) 
As described in your textbook, differential correction techniques require at least two proximate GNSS 
receivers to read satellite data simultaneously.  One receiver is installed at a fixed and known point; 
this receiver is called the “base” (e.g., a National Geodetic Survey CORS site).   The other receiver is 
mobile and used for fieldwork; this receiver is the “rover.”  Because the “base” is at a known spot and 
it measures that known spot over-and-over again, any difference between the actual coordinates 
(thanks NGS) and the measured coordinates (obtained via GPS) can be blamed on the GPS system.    
 
 

𝐷𝑖𝑓𝑓𝑒𝑟𝑒𝑛𝑐𝑒𝑏𝑎𝑠𝑒 @ 𝑡𝑖𝑚𝑒𝑥
= 𝐴𝑐𝑡𝑢𝑎𝑙𝑏𝑎𝑠𝑒 − 𝑀𝑒𝑎𝑠𝑢𝑟𝑒𝑑𝑏𝑎𝑠𝑒 @ 𝑡𝑖𝑚𝑒𝑥

 Eq. 1 

 
 

If we assume that your rover unit used the same satellites to measure positions as the nearest 
base station was using to measure itself, then any observed “differences” at the base can, in turn, be 
used to “correct” the data in the rover; hence, differential corrections. 
 
 

𝐶𝑜𝑟𝑟𝑒𝑐𝑡𝑟𝑜𝑣𝑒𝑟 @ 𝑡𝑖𝑚𝑒𝑥
= 𝑅𝑎𝑤𝑟𝑜𝑣𝑒𝑟 @ 𝑡𝑖𝑚𝑒𝑥

− 𝐷𝑖𝑓𝑓𝑒𝑟𝑒𝑛𝑐𝑒𝑏𝑎𝑠𝑒 @ 𝑡𝑖𝑚𝑒𝑥
      Eq. 2 
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Trimble GPS correction software performs differential correction swiftly.  Speed is great for the 
professional, but that same speed makes it difficult for students to watch what is happening and learn.  
So, follow these directions and you’ll be able to watch the process and get a better sense of how 
differences measured at the nearest CORS are used to correct your rover data. 
 

1. Open the Utilities > Differential Correction… utility.  You might be prompted to save your 
data file if you made any changes: the choice is yours to make. 

a. Select the SSF file(s) you wish to correct. 
i. [Next] 

b. Processing type 
i. Automatic Code and Carrier Processing (Recommended) 

ii. Use a single base provider 
iii. [Next] 

c. [Change…] the Correct Settings 
i. Output positions: 

1. Corrected only 
ii. Use new GPS Filtering settings: 

1. Elevation mask = 15° 
2. Minimum Signal-to-Noise ratio = 33 
3. Maximum PDOP = 6 
4. DO re-correct real-time code positions 
5. [OK] 

iii.  [Next] 
d. Base Data 

i. Use Base Provider Search and Select… the CORS, YORK (YORK), PENNSYLVANIA 
site, which is the closest base station.  Choosing this option instructs the 
software to access the CORS server via the Internet and request base station 
data. 

ii. DO use the position from the downloaded base files. 
iii. DO Confirm base data and base position before processing. 
iv. [NEXT] 

e. Output folder 
i. Use the same folder as the input file 

ii. Create a unique filename … 
iii. [START] 

 
Question 8:  How many base files, if any, did the software download for you? 
 
Question 9:  How much coverage (amount of temporal overlap, expressed as a percent) exists 

between your rover data and the base data? 
 

iv. [CONFIRM] 
 

Question 10:  Knowing that satellites-receiver geometry can change over time, it is likely that you 
measured some raw positions more precisely than others.  How many (#) and what 
share (%) of your corrected positions fell into each “range” of uncertainty?   
See Bolstad (2016) Figures 5-11, 5-12, and 5-31 
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v. [CLOSE] 
 

2. File > Close your uncorrected data file (*.SSF). 
3. File > Open your corrected data file (*.COR). 

 
Question 11:  Did you lose any features during differential correction?  (#,%)? 

 
 
Exporting your corrected data 
Follow these directions to export your corrected mural features from Trimble *.COR format to 
delimited text *.CSV format. 
 

1. Open the Utilities > Export… tool.   
a. Select your corrected (*.COR) data file as input for export. 
b. Choose your output folder (where the outputted CSV file will be saved). 
c. Choose the Sample Configurable ASCII Setup option. 
d. [Properties…] 

i. Data 
1. “Export all Features” 
2. Uncheck “Include Not in Feature Positions” 

ii. Output 
1. “For each input file create output file(s) of the same name.” 
2. System File Format: Windows. 

iii. Attributes (for the output attribute table) 
1. Export menu attributes as Attribute Value 
2. All features (check all of the following) 

a. PDOP 
b. HDOP 
c. Correction status 
d. Receiver type 
e. Date recorded 
f. Time recorded 
g. Data File Name 
h. Total positions 
i. Filtered positions 
j. Data Dictionary Name 

3. Point features (check at least the following) 
a. Vertical Precision 
b. Horizontal precision 

iv. Units 
1. Use Current Display Units 
2. Latitude/Longitude Options: DDD.dddddd  
3. Time format: 24 Hour clock 

v. Position Filter 
1. Position Filter Criteria 

a. Minimum Geometry = 3D (5 or more) 
b. Maximum PDOP = Any 
c. Maximum HDOP = 6 
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2. Include positions that are: 
a. Check every option except Uncorrected positions 

vi. Coordinate system 
1. Use Export Coordinate System [Change] 

a. System: Lat/Long 
b. Datum: WGS 1984 
c. Altitude units: Meters 
d. Altitude reference: MSL 

vii. Configurable ASCII 
1. File Options: One Set of Files  per Feature Type 
2. Template List 

a. [Delete] any templates that are there (e.g., pos, att, etc.) 
b. Make a [New…] template called CSV 

i. Output file extension: csv 
ii. Apply to: Points 

iii. Field format: Delimited 
iv. Delimiters 

1. Field: Comma (,) 
2. Text: Double Quotes (“) 
3. Decimal: Dot (.) 

v. Template Worksheet (see Figure 2 below) 
vi. {Feature ID} {Longitude} {Latitude} {MSL} ~ 

{Attributes} [New Line] 
3. [OK] 

e. [OK] 
 

 
Figure 2: ASCII Export Template Editor: You new CSV template 
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Question 12:  How many features were discarded because all their supporting positions did not pass 
through the export filter (see 1.d.v.1 above)? 

 
Close your file and exit GPS Pathfinder Office. 
 
Upload your mural photographs to your SHIP website. 
We need to put copies of your good mural photographs in a place that’s accessible via the Internet.  
Your SHIP website will work great for this.  So, in your GIS folder, make two subfolders: 1) 
MuralPhotos and 2) MuralThumbs.  Place copies of your originals in your MuralPhotos folder. 

To work best with ArcGIS Online, all the images in your MuralPhotos folder must be resized (or 
cropped) down to 1000 px wide, 750 px high.  Feel free to use Adobe Photoshop, IrfanView, or any 
other photo editing software that gives you fine control over your edits. 

Next, copy and paste all the images into your MuralThumbs folder.  The images in your 
MuralThumbs folder should then be resized (or cropped) further - down to 200 px wide, 150 px high. 
 
Upload your CSV file to Google Drive and share it with your professor 
Lastly, upload your CSV file to Google Drive and share it with me (sadrzy@gmail.com).  I don’t need 
full editing privileges, but I do need to be able to view it and to make comments.  We’re going to finish 
this lab together during class by building map applications with ArcGIS Online.   
 
Question 13:  This isn’t really a question; rather, a task.  Create a folder and name it using your 

lastname.  Next, make sure the folder contains copies of only the following: 
1. Your data dictionary (*.ddf) file; 
2. Your raw positions data file (*.ssf); 
3. Your differentially-corrected positions data file (*.cor); 

 
Use 7-Zip or another zipping utility to ZIP the folder.  Send me your ZIP file as an email 
attachment.  If you don’t use this link in the PDF sadrzy@ship.edu, then be sure to type 

“GIS3 GNSS” as your subject line. 
 
Deliverables 

Complete a well-written report of the lab exercise.  Include your name, date, and page 
numbers.  Your report should include five sections and headings: Purpose, Objectives, Methods and 
Data, Results and Answers, and Summary.  Provide concise purpose and objectives using your own 
words, and describe the important methods and input data you used to address the tasks listed above.  
In the Results and Answers section, address any issues or questions prompted during the lab.  Include 
tables and figures in the same order you refer to them. In the Summary section, describe how you 
accomplished the purpose of the lab (i.e., how well did you answer the research question); then 
identify anything that you learned, or anything that remains problematic.  Your List of References 
should list any and every published work that you used to support your work. 

All lab reports should be typed and printed on 8.5” by 11” stock.  Before drafting your report, 
set your left and top margins to 1.2” and set the others to 0.7”.  Enter your name, the lab title, and the 
date in your document header.  Use single line spacing in your header. 

For the body, set the normal font face to be Bookman Antiqua, Bookman Old Style, or 
Georgia; never use Times New Roman or any kind of decorative font.  Use 1.5 line spacing.  Set the normal 

font size to be 11 points.  Include page numbers on every page.  Major section headings should be in 
bold face.  All tables and figures must be inserted into the body of your report and conform to the 
formatting and margin requirements.   

mailto:sadrzy@gmail.com
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